
Explorative data science 
Unsupervised machine learning
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Ideal situation: We know about a measurable feature

Example: Inactivated vs. activated microglia in mouse brain

DAPI
OSP

Inactivated microglia Activated
Source: Slice2Volume, https://rodare.hzdr.de/record/1849, shared under CC-BY 4.0

Existing scores: “Ramification index” (Wittekind et al., 2022)

𝑅𝑎𝑚𝑚𝑖𝑓𝑖𝑐𝑎𝑡𝑖𝑜𝑛	𝑖𝑛𝑑𝑒𝑥 =
𝐴!
𝑨𝑷

Get Data

Measure defined score/features

Compare conditions

Be done JIdeal workflow
Cell

Solidity CircularityPerimeter

https://rodare.hzdr.de/record/1849
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More typical situation: We do not know about a feature

• We expect or know of a biological effect (e.g., through external cues, cell growth stages, etc.) 

• We do not know how this effect can be measured or how it manifests itself

Source: Mauricio Rocha Martins, Norden lab, MPI CBG

Example: 

Developing zebrafish eye

Hypothesis: Cells develop differently 
depending on where they are

Get Data

Measure … what exactly?

Compare … what exactly?

Be stuck L
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We can measure tons of features…
… but still have no idea about what’s happening!

Which of these features reflect interesting biology?

Source: Mara Lampert, FocalPlane, https://focalplane.biologists.com/2023/05/03/feature-extraction-in-napari/

https://focalplane.biologists.com/2023/05/03/feature-extraction-in-napari/
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Identify the feature with the strongest effect

We could plot all features against our data and check 
which feature shows the strongest effect

But this would lead to following challenges: 

• Features are not independent!
• Area and diameter
• Width and height

• A lot of redundant information 

• Strongest effect might be a combination of features

• Risk of misinterpretation

• Need fewer and independent features

• Need to transform parameter space into lower dimensional space:

Ø Matrix factorization methods
§ Principal component analysis (PCA)

Ø Neighbor Graphs
§ t-Distributed Stochastic Neighbour Embedding (t-SNE)
§ Uniform Manifold Approximation and Projection (UMAP)
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Axis of 2 nd-highest variance
Highest variance

2
nd-highest variance

Explained variance Component1: 0.98 
Explained variance Component2: 0.01

PCA

à PCA transforms width/height measurements into a coordinate system that explains existing variance better

PCA: Principal Component Analysis
Decomposes data into linear combinations of features that explain the highest variance
Example: Squares of different size 
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PCA: Principal Component Analysis
Decomposes data into linear combinations of features that explain the highest variance
Example: Squares of different size 

Step 1: Standardization

Case 1 
Heights: 0 … 30
Widths: 0 … 30

Case 2 
Area: 0 … 100
Circularity: 0 … 1

𝑧 =
𝑣𝑎𝑙𝑢𝑒 − 𝑚𝑒𝑎𝑛

𝑠𝑡𝑎𝑛𝑑𝑎𝑟𝑑 𝑑𝑒𝑣𝑖𝑎𝑡𝑖𝑜𝑛

Step 2: Covariance matrix computation to identify correlations

𝐶𝑜𝑣 ℎ𝑒𝑖𝑔ℎ𝑡, ℎ𝑒𝑖𝑔ℎ𝑡 𝐶𝑜𝑣(ℎ𝑒𝑖𝑔ℎ𝑡, 𝑤𝑖𝑑𝑡ℎ)
𝐶𝑜𝑣 𝑤𝑖𝑑𝑡ℎ, ℎ𝑒𝑖𝑔ℎ𝑡 𝐶𝑜𝑣 𝑤𝑖𝑑𝑡ℎ, 𝑤𝑖𝑑𝑡ℎ

+ Cov → variables correlated
- Cov → inversely correlated
= 0 → variables are independent

Variances

𝐶𝑜𝑣 ℎ𝑒𝑖𝑔ℎ𝑡, 𝑤𝑖𝑑𝑡ℎ = ℎ 6 𝑤 − ℎ 6 𝑤 =
1
𝑁9

!"#

$%&

ℎ!𝑤! −
1
𝑁9

!"#

$%&

ℎ!
1
𝑁9

!"#

$%&

𝑤!

𝑁 − 𝑛𝑢𝑚𝑏𝑒𝑟 𝑜𝑓 𝑑𝑎𝑡𝑎 𝑝𝑜𝑖𝑛𝑡𝑠
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Step 3: Calculation of Eigenvectors and Eigenvalues 

PCA: Principal Component Analysis
Decomposes data into linear combinations of features that explain the highest variance
Example: Squares of different size 

det 𝐶 − 𝜆𝐼 = 0

det(𝐶 − 𝜆𝐼) = 𝑑𝑒𝑡
𝐶𝑜𝑣 ℎ𝑒𝑖𝑔ℎ𝑡, ℎ𝑒𝑖𝑔ℎ𝑡 − 𝜆 𝐶𝑜𝑣(ℎ𝑒𝑖𝑔ℎ𝑡, 𝑤𝑖𝑑𝑡ℎ)
𝐶𝑜𝑣 𝑤𝑖𝑑𝑡ℎ, ℎ𝑒𝑖𝑔ℎ𝑡 𝐶𝑜𝑣 𝑤𝑖𝑑𝑡ℎ, 𝑤𝑖𝑑𝑡ℎ − 𝜆 =0

→ Solve equation for eigenvalues (λ)
→ Find eigenvectors (𝑣) by substituting each eigenvalue in     (𝐶 − 𝜆𝐼)v = 0

𝑣! =
𝑣!,#$%&#'
𝑣!,(%)'#

𝑣* =
𝑣*,#$%&#'
𝑣*,(%)'#

C	– covariance matrix
𝜆 - eigenvalues
𝐼 – identity matrix
𝑣 - eigenvectors

𝐼 = 1 0
0 1
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Step 4: Transformation to a new coordinate system

PCA: Principal Component Analysis
Decomposes data into linear combinations of features that explain the highest variance
Example: Squares of different size 

𝑇𝑟𝑎𝑛𝑠𝑓𝑜𝑟𝑚𝑎𝑡𝑖𝑜𝑛 𝑚𝑎𝑡𝑟𝑖𝑥 𝑇 =
𝑣!,#$%&#' 𝑣*,#$%&#'
𝑣!,(%)'# 𝑣*,(%)'#

𝑇 E
𝑤𝑖𝑑𝑡ℎ
ℎ𝑒𝑖𝑔ℎ𝑡 =

𝑐𝑜𝑚𝑝𝑜𝑛𝑒𝑛𝑡 1
𝑐𝑜𝑚𝑝𝑜𝑛𝑒𝑛𝑡 2

This is a linear operation!
Metrics remain meaningful

This works for any number of features!

𝑇 E
𝑓𝑒𝑎𝑡𝑢𝑟𝑒 1

…
𝑓𝑒𝑎𝑡𝑢𝑟𝑒 𝑁

=
𝑐𝑜𝑚𝑝𝑜𝑛𝑒𝑛𝑡 1
𝑐𝑜𝑚𝑝𝑜𝑛𝑒𝑛𝑡 2

P

Q

d1

A

d2

P’ Q’
d1’

A’
d2’

d1 > d2→ d1’ > d2’

Relative distances are preserved!

Great visualization tool for learning PCA: 
https://setosa.io/ev/principal-component-analysis/ by Victor Powell

https://setosa.io/ev/principal-component-analysis/


Slide 10 

PCA in Python: sklearn.decomposition.PCA

from sklearn.decomposition import PCA

• Import package

• Apply  PCA
pca = PCA(n_components=2)
pca.fit(standardized_data)

• Transform data into new coordinate system
transformed_data = pca.transform(data)

Important!
Always check the explained  variance 
along the PCA component axes!
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Disadvantages of PCA

• Sensitive to the scaling of the variables and outliers

• Linear algorithm → cannot represent complex
relationships between features

• Loss of information

Need an algorithm to deal with linearly non 
separable data
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Recap: Euclidean space

B

A

C

Characteristics:

• Distance between A and B is symmetric:

Ø 𝑑 𝐴, 𝐵 = 𝑑 𝐵, 𝐴
• Distance between A and B can be measured as the  

length (“norm”) of the vector 𝑨𝑩
• Distances satisfy the triangle inequality: 

𝑑 B, C ≤ 𝑑 C, 𝐴 + 𝑑 A, B

In other words:  there is no shorter path between two points 
other than a straight line

Source: Maps.google.de
License: https://about.google/brand-resource-center/products-and-services/geo-guidelines/#google-maps

Example: (local) 2D space
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More complex concept: Manifolds

From Wikipedia: “In mathematics, a manifold is a topological space that 
locally resembles Euclidean space near each point.”

…This map  is non-Euclidean!

à The two vectors 𝑷𝑸 and 𝑨𝑩 have the same length, but the 
real distances (the norm) of both are completely different!

à Cropping a small piece from the map gives us a local 
Euclidean space, where the previous assumptions hold.

A B

P Q

Mapy.cz, https://licence.mapy.cz/?doc=mapy_pu

https://licence.mapy.cz/?doc=mapy_pu
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More complex concept: Manifolds

From Wikipedia: “In mathematics, a manifold is a topological space that 
locally resembles Euclidean space near each point.”

…This map  is non-Euclidean!

à The two vectors 𝑷𝑸 and 𝑨𝑩 have the same length, but the 
real distances (the norm) of both are completely different!

à Cropping a small piece from the map gives us a local 
Euclidean space, where the previous assumptions hold.

Mapy.cz, https://licence.mapy.cz/?doc=mapy_pu

Approximately true country sizes
Source: Jakub Nowosad
(CC BY-SA 4.0)

https://licence.mapy.cz/?doc=mapy_pu
https://creativecommons.org/licenses/by-sa/4.0
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t-Distributed Stochastic Neighbour Embedding (t-SNE)
Reduce dimensionality preserving local structure (neighbours)

• Find a manifold that represents the data in fewer dimensions → ability to visualize the data

• Preserve local neighbours at the expense of distance distortions

Many dimensions

Reduced space to 2 dimensions

Global 
distances 
distorted

Nearest 
neighbours 
preserved
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Source: Wikipedia (CC BY-SA 4.0)

t-Distributed Stochastic Neighbour Embedding (t-SNE)

https://en.wikipedia.org/wiki/MNIST_database
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Source: Wikipedia (CC BY-SA 4.0)

t-Distributed Stochastic Neighbour Embedding (t-SNE)



Slide 18 

High dimensionality

t-Distributed Stochastic Neighbour Embedding (t-SNE)

• Loss function – Kullback-Leibner divergence (ℒ) between pairwise similarities (affinities) in the high-
dimensional and in the low-dimensional spaces. Similarities are defined such that they sum to 1.

• High price for putting close neighbors far away.

ℒ = ∑𝒊,𝒋𝒑𝒊𝒋𝒍𝒐𝒈
𝒑𝒊𝒋
𝒒𝒊𝒋

p − High dimensional similarities

Low dimensionalityHigh dimensionality

𝑥%
𝑥0

𝑦0

𝑦%

𝑝0|% =
exp(− 𝑥% − 𝑥0

*
/2𝜎%*)

∑23% exp(− 𝑥% − 𝑥2
*
/2𝜎%*)

Kernel width is adaptively 
chosen adaptively to achieve 
the desired perplexity

Euclidean distance
(or any other)

0

The larger the distance, the smaller 𝑝!|#

p

0

exp(−𝑥$/(2 < 𝜎$))1

q − Low dimensional similarities

Hinton et al. Stochastic neighbor embedding, 2002
Maaten et al. Visualizing data using t-SNE, 2008
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t-Distributed Stochastic Neighbour Embedding (t-SNE)

• Loss function – Kullback-Leibner divergence (ℒ) between pairwise similarities (affinities) in the high-
dimensional and in the low-dimensional spaces. Similarities are defined such that they sum to 1.

• High price for putting close neighbors far away.

ℒ = ∑𝒊,𝒋𝒑𝒊𝒋𝒍𝒐𝒈
𝒑𝒊𝒋
𝒒𝒊𝒋

p − High dimensional similarities

Low dimensionalityHigh dimensionality

𝑥%
𝑥0

𝑦0

𝑦%

q − Low dimensional similarities

Hinton et al. Stochastic neighbor embedding, 2002
Maaten et al. Visualizing data using t-SNE, 2008

𝑞%0 =
𝑤%0
𝑍 𝑤%0 = 𝑘( 𝑦% − 𝑦0 )

𝑍 =c
23?
𝑤2?

All pairwise distances 
over the entire dataset:

Similarity kernel (𝑘):
• In the original SNE paper Gaussian kernel
• t-SNE paper introduced Student t-distribution with 1 

degree of freedom (heavy tails) to avoid crowding issue

𝑘 𝑑 =
1

1 + 𝑑#

𝑘 𝑑 = exp −𝑑#
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t-Distributed Stochastic Neighbour Embedding (t-SNE)

• Starting from a random configuration of the same number of
points in low dimensional space

• Close neighbours attract each other while all points repulse
each other → High price for putting close neighbors far away

• Attraction-repulsion forces are computed for each data point,
and a small step is made in the direction of this gradient (that
is, you move all the points), and then the gradient is
recomputed

Gradient Descent for Optimizing the Loss

p − High dimensional similarities

q − Low dimensional similarities

ℒ = ∑𝒊,𝒋𝒑𝒊𝒋𝒍𝒐𝒈
𝒑𝒊𝒋
𝒒𝒊𝒋

Constant

ℒ = ∑𝒊,𝒋𝒑𝒊𝒋𝒍𝒐𝒈
𝒑𝒊𝒋
𝒒𝒊𝒋
= ∑%,0 𝑝%0 E log 𝑝%0 − ∑%,0 𝑝%0 E log 𝑞%0

Constant

ℒ = ∑𝒊,𝒋𝒑𝒊𝒋𝒍𝒐𝒈
𝒑𝒊𝒋
𝒒𝒊𝒋
= ∑%,0 𝑝%0 E log 𝑝%0 − ∑%,0 𝑝%0 E log 𝑞%0 = −∑%,0 𝑝%0𝑙𝑜𝑔

($%
A
= −∑%,0 𝑝%0log(𝑤%0) + ∑%0 𝑝%0 𝑙𝑜𝑔𝑍

= 1

“Attraction of neighbors”: 
the distance should be as small 
as possible in the low-dim space

“Repulsion” between 
all the pairs for balance

Derivative is 
taken to 
compute the 
gradient

Video
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Uniform Manifold Approximation and Projection (UMAP)

Advantages over t-SNE:

• Increased speed (projection of 70 000 point MNIST dataset < 3 
minutes in comparison to 45 min for scikit-learn's t-SNE)

• Scales well in terms of both dataset and dimensionality

• Better preservation of the data’s global structures

• Builds mathematical theory to justify the graph based approach

UMAP constructs a high dimensional graph representation of the 
data then optimizes a low-dimensional graph to be as structurally 
similar as possible.

https://umap-learn.readthedocs.io/en/latest/how_umap_works.html
Interesting UMAPs https://johnhw.github.io/umap_primes/index.md.html

UMAP projection of MNIST dataset

https://umap-learn.readthedocs.io/en/latest/how_umap_works.html
https://johnhw.github.io/umap_primes/index.md.html
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1.0

1.0

Uniform Manifold Approximation and Projection (UMAP)

High dimensionality

𝑥%
𝑥0

𝑝%|0 = exp((− 𝑥% − 𝑥0
*
− 𝜌%)/𝜎%)

Distance to the nearest neighbor

• The data suggests an underlying structure (“topology”) but we do not have a model for it.

• UMAP constructs a high dimensional graph representation of the data then optimizes a 
low-dimensional graph to be as structurally similar as possible.

𝑥%
0

𝑥0
Similarity score

𝑙𝑜𝑔$ 𝒏𝒓 𝒐𝒇 𝒏𝒆𝒊𝒈𝒉𝒃𝒐𝒓𝒔 = 𝑙𝑜𝑔$3 = 1.6

Sum of 
similarity 

scores

Scores are made symmetrical:
Fuzzy union operation

𝑺𝒚𝒎𝒎𝒆𝒕𝒓𝒊𝒄𝒂𝒍 𝒔𝒄𝒐𝒓𝒆 = 𝑝% + 𝑝$ − 𝑝%𝑝$

Both points have the same
similarity scores even though
one is further one due to the
theoretical framework of UMAP
(topology and fuzzy sets)

𝑝% = 0.6
𝑝$ = 1.0

1.0

https://umap-learn.readthedocs.io/en/latest/how_umap_works.html

Large number of neighbors → Global structure preserved
Small number of neighbors → Local structure preserved

Same distances!

https://umap-learn.readthedocs.io/en/latest/how_umap_works.html
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Uniform Manifold Approximation and Projection (UMAP)

High dimensionality

𝑥%
𝑥0

𝑣(𝑑%0) =
1

1 + 𝛼(𝑦% − 𝑦0 )*\

Goal: to optimize the low dimensional representation to have as close a fuzzy topological representation as 
possible as measured by binary cross entropy via the stochastic gradient descent

Low dim
similarity 
score

Low dimensionality

Initialization of a low-dimensional
graph using Spectral Embedding

Default: 𝛼 = 1.577; 𝛽 = 0.8951

NOTE: if 𝛼 = 1 𝑎𝑛𝑑 𝛽 = 1
then low-dim scores are equal to the 
ones that t-SNE uses
→ UMAP gives more control how 
tightly packed low-dim space ends up

NOTE: In contrast to t-SNE, which
uses random initialization (unless
other initialization is chosen, e.g. with
PCA), resulting low-dimensional graph
is the same each run on the same
dataset

𝑦% 𝑦0

𝐶𝐸 𝑦# , 𝑣 =k
!

−𝑝#|!𝑙𝑜𝑔𝑣 𝑑#! + 1 − 𝑝#|! 𝑙𝑜𝑔(1 − 𝑣(𝑑#!))

𝑤ℎ𝑒𝑟𝑒 𝑑#! = 𝑦# − 𝑦!

“Attraction” of neighbors: 
the distance should be as small 
as possible in the low-dim space

Known weights of edges 
from high dimensional 
manifold approximation “Repultion” of 

distant points
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Things to Consider

• Many parameters invite to “adjust” the data analysis, and final results depend a lot on hyperparameters

• Danger to over-interpret the visual “distance”: distances between clusters might not mean anything

• How much data structure is preserved is still a matter of debate

• Random noise might not always look random

• Cluster size might not mean anything
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Dimensionality Reduction for Whole Slide Images

Whole slide imageBiopsy/resection Microscope slide

``

``

``

``

Tessellation

…

Feature extractor

UMAP source: Didem Çifçi, Kather lab

Whole Slide Image Source: The Cancer Genome Atlas, National Cancer Institute

``

Neural network
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Dimensionality Reduction for Whole Slide Images

Whole slide imageBiopsy/resection Microscope slide

``

``

``

``

Tessellation

…

Feature extractor

UMAP source: Didem Çifçi, Kather lab

Whole Slide Image Source: The Cancer Genome Atlas, National Cancer Institute

``

Neural network
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How to choose the best algorithm for your data?

• Depends on the dataset

• Subjective assessment of obtained results

How to compare different low dimensional 
embeddings?

• Lack of robust statistical approaches available to 
compare different results

• There is some literature trying to fill this gap 
(Roca et al., 2023)

Roca et al., (2023). A cross entropy test allows quantitative statistical comparison of t-SNE and 
UMAP representations. Cell Reports Methods, 3(1).
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Unsupervised Machine Learning

Unsupervised machine learning algorithms try to find any similarities, differences, patterns, and structure in 
data by itself, without the provided ground truth (labels).

Aspect ratio
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Unsupervised Machine Learning

Unsupervised machine learning algorithms try to find any similarities, differences, patterns, and structure in 
data by itself, without the provided ground truth (labels).

Aspect ratio
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Circular Elongated
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K-Means Clustering

Randomly initialized 
centroids

Goal: group data points into 𝑘 groups so that variance within group is minimal.

STEP 1: 𝑘 initial centroids are randomly initialized. 
These centroids are the "centers" of the initial clusters.

STEP 2: each data point is assigned to the nearest 
centroid. The "nearest" is typically determined by the 
Euclidean distance between the data point and the 
centroid. This forms 𝑘 clusters.

𝑑 𝑝, 𝑞 = -
&'(

)

𝑝& − 𝑞& #

𝑛 – dimensionality, in this example = 2
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K-Means Clustering

Goal: group data points into 𝑘 groups so that variance within group is minimal.

𝑑 𝑝, 𝑞 = -
&'(

)

𝑝& − 𝑞& #

STEP 1: 𝑘 initial centroids are randomly initialized. 
These centroids are the "centers" of the initial clusters.

STEP 2: each data point is assigned to the nearest 
centroid. The "nearest" is typically determined by the 
Euclidean distance between the data point and the 
centroid. This forms 𝑘 clusters.

𝑛 – dimensionality, in this example = 2 𝑞(

𝑝#

𝑞#

𝑝(

= 𝑝( − 𝑞( # + 𝑝# − 𝑞# #
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K-Means Clustering

Goal: group data points into 𝑘 groups so that variance within group is minimal.

New centroid& =
1
𝐶&

-
*∈,!

𝑥

STEP 3: Recalculation of centroids of the clusters 
formed by taking the mean of all points assigned to 
each cluster.

𝐶# - the number of data points in cluster i

Repeat steps 2-3: the assignment and update steps 
are repeated iteratively until one of the following 
conditions is met:
• The centroids do not change (or their changes are 

below a certain tolerance).
• The assignments do not change (no data point 

moves to a different cluster).
• A predetermined number of iterations is reached.
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K-Means Clustering

Goal: group data points into 𝑘 groups so that variance within group is minimal.

New centroid& =
1
𝐶&

-
*∈,!

𝑥

STEP 3: Recalculation of centroids of the clusters 
formed by taking the mean of all points assigned to 
each cluster.

𝐶# - the number of data points in cluster i

Repeat steps 2-3: the assignment and update steps 
are repeated iteratively until one of the following 
conditions is met:
• The centroids do not change (or their changes are 

below a certain tolerance).
• The assignments do not change (no data point 

moves to a different cluster).
• A predetermined number of iterations is reached.
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K-Means Clustering

Goal: group data points into 𝑘 groups so that variance within group is minimal.

New centroid& =
1
𝐶&

-
*∈,!

𝑥

STEP 3: Recalculation of centroids of the clusters 
formed by taking the mean of all points assigned to 
each cluster.

𝐶# - the number of data points in cluster i

Repeat steps 2-3: the assignment and update steps 
are repeated iteratively until one of the following 
conditions is met:
• The centroids do not change (or their changes are 

below a certain tolerance).
• The assignments do not change (no data point 

moves to a different cluster).
• A predetermined number of iterations is reached.
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K-Means Clustering

Goal: group data points into 𝑘 groups so that variance within group is minimal.

New centroid& =
1
𝐶&

-
*∈,!

𝑥

STEP 3: Recalculation of centroids of the clusters 
formed by taking the mean of all points assigned to 
each cluster.

𝐶# - the number of data points in cluster i

Repeat steps 2-3: the assignment and update steps 
are repeated iteratively until one of the following 
conditions is met:
• The centroids do not change (or their changes are 

below a certain tolerance).
• The assignments do not change (no data point 

moves to a different cluster).
• A predetermined number of iterations is reached.
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K-Means Clustering
In Python
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K-Means Clustering
In Python

Advantages & Disadvantages:

• Simplicity and Speed

• Easy to interpret results

• Well-suited for spherical clusters and of similar size

• Based on Euclidean distance → every new point can 

be assigned to a cluster

• Number of clusters needs to be known

• Vulnerability to outliers

• Difficulty with varying densities

• Convergence to local minima

• Clusters can not capture more complex topologies
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Hierarchical Density-Based Spatial Clustering of Applications with Noise (HDBSCAN)

Unlike K-means which uses centroid-based clustering, HDBSCAN relies on density-based clustering. 

→ Assumes that clusters are defined as areas of higher density than the remainder of the dataset, which allows 
it to find arbitrarily shaped clusters and handle noise (outliers) effectively.

https://hdbscan.readthedocs.io/en/latest/how_hdbscan_works.html

https://hdbscan.readthedocs.io/en/latest/how_hdbscan_works.html


Slide 39 

Hierarchical Density-Based Spatial Clustering of Applications with Noise (HDBSCAN)

STEP 1: Transform the space according to the density/sparsity.

https://hdbscan.readthedocs.io/en/latest/how_hdbscan_works.html

Core distance: Distance to n-th nearest neighbor
Distance metric: Mutual reachability
Core distance of Q	>	d(P,	Q)	→ dnew(P,Q) =	core	distance
Core distance of Q	< d(A,	Q) → dnew(A,Q) =	d(A,Q)

à Isolated points are pushed further away from clusters

“To find clusters we want to find the islands of higher density 
amid a sea of sparser noise […] For practical purposes that 
means making ‘sea’ points more distant from each other and 
from the ‘land’.”

https://hdbscan.readthedocs.io/en/latest/how_hdbscan_works.html
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Hierarchical Density-Based Spatial Clustering of Applications with Noise (HDBSCAN)

STEP 2: Build the minimum spanning tree of the distance weighted graph.

STEP 3: Construct a cluster hierarchy of connected components.

https://hdbscan.readthedocs.io/en/latest/how_hdbscan_works.html

Sort edges 
by 

distances 
& 

Merge 
close points

https://hdbscan.readthedocs.io/en/latest/how_hdbscan_works.html
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Hierarchical Density-Based Spatial Clustering of Applications with Noise (HDBSCAN)

STEP 4: Condense the cluster hierarchy based on minimum cluster size. Traverse graph from top to bottom and 
decide whether a new cluster is formed at every crossroads

https://hdbscan.readthedocs.io/en/latest/how_hdbscan_works.html

1. If points are split into clusters here – are both clusters 
larger than a size threshold? Yes

2. No – this part of the tree remains a single cluster

3. No – this part of the tree remains a single cluster

4. Yes – remaining points are split into new clusters here

1

2
3
4

https://hdbscan.readthedocs.io/en/latest/how_hdbscan_works.html
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Hierarchical Density-Based Spatial Clustering of Applications with Noise (HDBSCAN)

STEP 5: Extract the stable clusters from the condensed tree.

Extracting the clusters with ‘largest total ink area’ leads to the final selection of clusters

https://hdbscan.readthedocs.io/en/latest/how_hdbscan_works.html

Each point is assigned a 
cluster membership 
probability

https://hdbscan.readthedocs.io/en/latest/how_hdbscan_works.html
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Variants of Linkage-clustering

There are multiple ways to reconstruct the neighborhood graph and 
the  clusters in the hierarchy schematic:

- Setting a maximum distance between two points to be considered 
neighbors à DBSCAN
https://scikit-
learn.org/stable/modules/generated/sklearn.cluster.DBSCAN.html

- Aggregate points into clusters bottom-up à Agglomerative 
clustering
https://scikit-
learn.org/stable/modules/generated/sklearn.cluster.Agglomerativ
eClustering.html

https://scikit-learn.org/stable/modules/generated/sklearn.cluster.DBSCAN.html
https://scikit-learn.org/stable/modules/generated/sklearn.cluster.DBSCAN.html
https://scikit-learn.org/stable/modules/generated/sklearn.cluster.AgglomerativeClustering.html
https://scikit-learn.org/stable/modules/generated/sklearn.cluster.AgglomerativeClustering.html
https://scikit-learn.org/stable/modules/generated/sklearn.cluster.AgglomerativeClustering.html
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Interactive Hands-On Session with Napari
Data preparation, feature extraction, feature exploration, clustering, dimensionality reduction
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Recap: Environment Preparation

Install conda/miniforge/mamba/micromamba on your machine:

https://biapol.github.io/blog/mara_lampert/getting_started_with_mambaforge_and_python/readme.html

Follow installation instructions for devbio-napari collection of napari plugins:

https://github.com/haesleinhuepf/devbio-napari

https://biapol.github.io/blog/mara_lampert/getting_started_with_mambaforge_and_python/readme.html
https://github.com/haesleinhuepf/devbio-napari
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Dataset: Image Set of Human HT29 Colon-cancer Cells (BBBC021)
Broad Bioimage Benchmark Collection (BBBC)

Download data from:

https://bbbc.broadinstitute.org/BBBC021

Key Features of BBBC021:

• Images: The dataset contains thousands of images, each corresponding to a well of a microplate where cells 
have been treated with a different compound.

• Labels: Each image is associated with a compound and often a MoA, providing a clear label for supervised 
learning tasks. We will use this as a ground truth to compare against the clusters discovered.

• Metadata: Includes details about the compound, dose, and batch, which can be used to perform more 
nuanced analyses and correct for batch effects. ← Not part of this workshop

The BBBC resource is described in the following publication: Ljosa V, Sokolnicki KL, Carpenter AE (2012). 
Annotated high-throughput microscopy image sets for validation. Nature Methods 9(7):637 / doi. PMID: 
22743765 PMCID: PMC3627348. Available at http://dx.doi.org/10.1038/nmeth.2083

The dataset is designed for evaluating the ability to predict 
biological mechanisms of action (MoA) based on morphological 
changes in cells caused by chemical compounds. The images have 
been treated with 113 different small-molecule compounds at 
various concentrations, resulting in a variety of cellular phenotypes.

https://bbbc.broadinstitute.org/BBBC021
http://dx.doi.org/10.1038/nmeth.2083
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Dataset: Image Set of Human HT29 Colon-cancer Cells (BBBC021)
Broad Bioimage Benchmark Collection (BBBC)

Download data from:
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biological mechanisms of action (MoA) based on morphological 
changes in cells caused by chemical compounds. The images have 
been treated with 113 different small-molecule compounds at 
various concentrations, resulting in a variety of cellular phenotypes.

https://bbbc.broadinstitute.org/BBBC021
http://dx.doi.org/10.1038/nmeth.2083
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Data Preparation: Segmentation of all 3 channels
Nuclei (DAPI, blue) channel

Perform interactive segmentation in napari 
(only one timepoint):
• Open one of the prepared dataset images
• Right click on the layer → split RGB
• Now for the layer that you want to process: 

Plugins → convert to 2D timelapse

Segment nuclei channel:

Plugins → Assistant (napari-assistant) 
→ Remove noise (gaussian blur) 
→ Binarize (Threshold Otsu) 
→ Process labels (Split touching objects, sigma=4) 
→ Process labels (Erode labels) 
→ Label (Connected component labelling, scikit-image)

Same steps in the notebook!
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Data Preparation: Segmentation of all 3 channels
Actin (Green) channel

Perform interactive segmentation in napari 
(only one timepoint):
• Open one of the prepared dataset images
• Right click on the layer → split RGB
• Now for the layer that you want to process: 

Plugins → convert to 2D timelapse

Segment actin channel:

Plugins → Assistant (napari-assistant) 

→ Binarize (Theshold Huang and Wang 1995)
→ Remove noise (Median sphere) 
→ Filter (Sobel, Detect edges) 
→ Label (Seeded watershed with nuclei as seeds and 
binary mask, only in the notebook!)

Final result only in the notebook!
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Data Preparation: Segmentation of all 3 channels
Tubulin (Red) channel

Perform interactive segmentation in napari 
(only one timepoint):
• Open one of the prepared dataset images
• Right click on the layer → split RGB
• Now for the layer that you want to process: 

Plugins → convert to 2D timelapse

Segment tubulin channel:

Plugins → Assistant (napari-assistant) 

→ Binarize (Theshold Huang and Wang 1995)
→ Remove noise (Median sphere) 
→ Label (Seeded watershed with nuclei as seeds and 
binary mask, only in the notebook!)

Final result only in the notebook!
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Data Preparation: Extracting Quantitative Measurements

Perform interactive measurements 
extraction in napari:
• Open one of the prepared dataset images
• Right click on the layer → split RGB
• Open corresponding segmentation images
• Now for each layer: 

Plugins → Convert to 2D timelapse

• Tools → Measurement tables → Label 
statistics of all frames (clEsperanto)

Same steps in the notebook!
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Dimensionality Reduction & Clustering

Interactively with napari-clusters-plotter 



Slide 53 

Image-based Profiling

Ground truth: 6 of the 12 mechanisms can be identified visually:

• Actin disruptors

• Aurora kinase inhibitors

• Eg5 inhibitors

• Microtubule destabilizers

• Microtubule stabilizers

• Epithelial

Can you identify any of the features that are important for any of these mechanisms?


